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Disclaimer

Competition Systems Inc. Racepak make no representations or warranties of any type with respect to the
contents in this manual. Competition Systems Inc. Racepak disclaim any implied warranties or fitness for any
particular purpose. Competition Systems Inc. Racepak is not liable for any errors contained within or for
incidental or consequential damages in connection with the supply, performance or use of the hardware and
software or this manual.

Competition Systems Inc. Racepak reserve the right to revise this installation and user manual at any time,
without obligation to notify any person of revisions.

Warranty

Competition Systems Inc. Racepak make every effort to insure our products and services are of the highest
quality and standards. It is our intention to maintain a mutually beneficial and cordial relationship with each
and every customer.

Competition Systems Inc. Racepak warrants all merchandise manufactured by Competition Systems Inc.
Racepak against defects in workmanship or material for a period of six months after the data of purchase. This
warranty applies to the first retail purchaser and covers only those products exposed to normal use or service. It
does not apply to those products used for a purpose for which said products were not designed, or which has
been altered in any way that would be detrimental to the performance or life of the product, or misapplication,
misuse, negligence, or accident. Any part or product found to be defective after examination by Competition
Systems Inc. Racepak will be repaired or replaced. Competition Systems Inc. Racepak assumes no
responsibility for diagnosis, removal and/or installation labor, loss of vehicle use, loss of time, inconvenience or
any other consequential expenses.

This warranty is in lieu of any other expressed or implied warranties, including any implied warranty or
merchantability or fitness, and any other obligation on the part of Competition Systems Inc. Racepak, or selling
dealer.

If you have any questions regarding warranty, please contact customer service at Competition Systems Inc.
Racepak. 949-709-5555



Introduction

Solving the wiring complexity of a modern race car, the Racepak SmartWire is a fully programmable power
control module. While traditional wiring provides control of vehicle electronic components through the routing
of single, or multi-fuse, relay, and circuit breaker panels, the Racepak SmartWire functions as a central
“command center” for all vehicle wiring.

Based on Racepak’s exclusive single cable V-Net technology, the Racepak SmartWire unit is the electronic
“starting point”, with a direct main power connection from the vehicle battery to the SmartWire unit. Each
output is user defined, both in function, current requirement and current limit via a USB connection to the user’s
PC. The design of the SmartWire unit will reduce overall installation weight / clutter, while contributing to a
quicker reacting electronic system, through the solid state switching design.

Manual activation can be achieved through the 12 hardwired direct inputs on the SmartWire unit, or through the
use of the optional Racepak SwitchPanel or SwitchModule units. When utilized, a single small cable is routed
to the SwitchPanel/SmartModule from the Racepak SmartWire unit, reducing wiring clutter. Users needing
additional switch panel capabilities can easily expand through the use of an additional “jumper” cable to a
second Racepak SwitchPanel/SmartModule.

The Racepak V-Net compatibility of the SmartWire unit insures a seamless integration with existing Racepak
V-Net equipped vehicles. When connected with existing V-Net equipment, these items provide additional
inputs, control modules and instrumentation, compared to when utilized as a standalone power control module.

This manual will provided you step by step guidance through the installation, setup, and operation of the
SmartWire unit. During this process, the manual may refer to system worksheets and individual instruction
sheets originally provided with other Racepak sensor modules and devices.

To get the most out of the Racepak SmartWire unit, it is highly recommended to thoroughly read the
entire manual before installation and use of the Racepak SmartWire unit. In addition, test the
SmartWire unit and settings/functions before use. The race track is not the place to determine something
is not working properly!

Racepak
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Technical Specifications

Output Capacity: 125 Amps

Current Consumption: 180 mA typical operation (<1 mA in shutdown mode)

Min/Max Power Supply: 8-20 Volts

Operating Power Supply: 12-16 volt automotive applications.

Inputs: 12 hardwired direct (voltage triggered (>2.7V) or ground triggered (<2.5V)
Outputs: 30 (8 outputs @ 20 Amps, 22 outputs @ 10Amps)

Response: 3.0 milliseconds max.

Programming: USB (or via V-Net when used with a V-Net data recorder)

Dimensions: Length 6.5” (16.51 cm), Width 5.5” (13.97 cm), Height 2.0 (5.08 cm)
Weight: 25.8 ounces (731.4 grams)

Note: All current ratings are for 12 volt operation. For 16 volt systems, subtract 25 percent.

Connections:
e Two - 23 pin Ampseal, (hardwired direct inputs, outputs, grounds and shutdown pin)
e One - 1/4”x 20 Main Stud, (main power supply)
e One USB mini (programming when utilized without a compatible data recorder)
e One Switch CAN bus (connection for optional Switch Panel and/or Switch Module)
e One V-Net CAN bus (connection for optional V-Net sensors and/or compatible data recorders)

Outputs are:
e Monitored for Current, Voltage, and Status

e Protected via user settable limits for over-current situations
e Protected from short circuits and/or thermal overload situations
e Function programmable as:
o Constant On
o Flash
o Latch On
o Single Pulse
o Windshield Wiper (only available on channel 19)
e Time Delayed for On or Off
¢ Outputs are controlled via any combinations of:
o Switchable inputs
o Programmed logic operations;
= (Equal to, Not Equal to, Greater than, Greater than or Equal to, Less than, Less than or
Not Equal to)
o V-Net attached sensors (Temperatures, Pressures, RPM, etc.)
o Other Outputs

Racepak
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Becoming Familiar with the SmartWire Installation

This manual is designed to provide guidance through the programming of the SmartWire unit. Use of this
manual, along with the SmartWire Installation manual, will provide complete installation and programming
instructions. Below is an overview of a typical installation and setup.

Utilizing the SmartWire Software/Programming manual, install the DatalinkII software on PC

Install only the main power and grounds on the SmartWire

Connect SmartWire to PC using supplied USB cable

Utilizing the SmartWire Programming Installation manual, open the configuration file on PC

Sync the configuration file with the SmartWire

Name, program, and send each of the inputs (Hardwired direct inputs). Smart Panel/Smart Module and
V-Net items can be programmed at this time if connected. Or, each can be programmed at a later date.
7. Name, program, and send each of the outputs (ensure correct Amperage rating for each device)

8. Wire each of the inputs per programmed settings (see Hardware Installation Manual)

9. Wire each of the outputs per programmed settings (see Hardware Installation Manual)

10. Test each of the input and output settings. Insure each circuit operates as intended

A

Pre-Install notes:

It is recommended to initially install the Main Power and Ground wires first in order to program
& each input and output. Once programmed, terminate and wire only the necessary connections. Do
not terminate every connection, unless a device will be connected.

f The SmartWire can be installed and utilized as a standalone unit (i.e. not connected to a data
recorder) or is compatible with the following Racepak data recorders:
e V300 (firmware version 41 or higher)
e V300SD (firmware version 22 or higher)
e V500 (firmware version 56 or higher)
e IQ3 Logger Dash (firmware version 15 or higher)
¢ 1Q3 Display Only non-logger Dash (firmware version 17 or higher)
e  G2X Pro (firmware version 57 or higher)

If the PC does not meet the above firmware requirement, contact Racepak for update details.

Portions of this manual will call out two installing/programming types; Standalone AND with a
& Data Recorder. In Standalone mode, all programming is performed via USB cable between the
PC and the SmartWire unit.

When utilized with Racepak V-Net sensors or in conjunction with a Racepak data recorder,
programming is performed via serial connection between the PC and the data recorder unit.

Racepak
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Example Installation Overview

In a standard switch/device application, power is routed to a switch, with this switch controlling one device.
Depending on the device current (Amperage) requirement, this switch controls a relay, when triggered, allows a
large amount of current flow to the device. Activating the device requires manually flipping a switch.

Two Switches:
One for Water Pump

Standard switch installation: One for Fan . /M\
_ _ Fuse  Switch ) L
One switch for each device. — Water Pump =
Fuse Switch l
Switch on, device on. —ﬂ " _T_Relav % J__
- Fan -
Battery

Basic SmartWire installation

One switch for each device. Two Switches: szl‘;t}:llre Qﬂ/ 1
. . One for Water Pump ni Water P =

Switch on, device on. One for Fan Outouts ater Fump
Monitors on both devices for: o———p % 1
[ ] o———P

Current (Amps) Hardwired Battery Input F =
® Voltage Inputs an
® Status (on/off/blown fuse) _l__ll'l i

Battery

Option #1 SmartWire installation

One switch for both devices. SmartWire @ 1
. . Unit —

Switch on, both devices on. One Switch for both Outputs Water Pump =

SmartWire can toggle both devices on/off at

set timer intervals Hardwire d’ %

Monitors both devices for: Input Battery Input J:‘

=1

® Current (Amps) _|__IL Fal
® Voltage = [1

® Status (on/off/blown fuse)

Battery

Option #2 SmartWire installation V-Net to
SmartWire
[ — TR s
One switch for manual override, V-Net sensor used Water
for trigger V-Net Input Temp
V-Net Port Module & Sensor

Switch on, devices on regardless of temperature " 1
. SmartWire
input. A m

. Unit M
Switch off; SmartWire is programmed to One Switch for both: M)/
automatically turn both devicgs on at user set Force both on Outputs Water Pump =
temperatures based on V-Net input. SmartWire can o———P
toggle both devices on/off at set timer intervals Hardwired

Input Battery Input
Sensor failure, SmartWire can be programmed to J__
force devices on should temperature go outside J_—j,l Fan -
sensor readable scale regardless of switch position. - Il
Monitors both outputs/devices for: Battery
® Current (Amps)
® Voltage
® Status (on/off/blown fuse)
Racepak
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Option #3 SmartWire installation in conjunction with Racepak V-Net data recorder

When connected to a V-Net data recorder, each sensor can be utilized for on/off function or logic control of
each device connected to the SmartWire. Optional Racepak Switch Panels or Switch Modules can also added
and connected to the SmartWire for more inputs and/or control.

Optional Switch Panel

O dadddaa
Fuel Pump
Sensor Sensor
To Display  Input To Data Input @ 1
Voltage triggered switches Dash Recorder e
P
oo 00 00 A
[ S - —— .
gg gg Optional =
88 80 Switch Water pump
o400 00 Module
| : 00 0o
© 00 oo
p— N——
Ground triggered ) Fan
switches Optional
Optional Switch I\:1_I:I1tcst
Panel Inputs P
Ground —o0 o—p Switch port V-Net port -
triggered ¢—c o—Pp|
Switches ¢—c o—P] R Solenoids
o SmartWire —N
— i —> V
— Unit >
= > Outputs to
> additional
Hardwired Inputs Outputs » devices
> = =
Voltage b—0 0——— P
triggered —c o——P
Switches b—o0 0————P
Battery Input
p—0 o——P .
Main stud
Ground v~ WA
(3 wires) <O> <Q>
£ A
- Lights
Starter — —
Solenoid - -
Ignition
Cut-Off J_:
Switch -
ECU
Main Power from Battery —_E
or cut-off switch - V-Net Data |g---
- - Recorder

Note: Most ignition and ECU systems require a direct main power connection.
This main power connection must go directly to the battery. DO NOT connect
the main power wire from these devices to the SmartWire outputs. Each of
these devices will also have a small wire requiring an ignition switched power
source. This small wire will connect to an output from the SmartWire.

Racepak
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DatalinklII Software Installation

The DatalinklII software is utilized to program the SmartWire unit. If a previous version of DatalinkII exists on
the programming PC, update to the latest DatalinkII software (version 3.8.4 or higher), included with the
SmartWire package.

Please note that “DatalinkII ” is the latest generation of Racepak software and supersedes the first generation
known as DatalinkIl. DatalinkII began with version 1.0. Therefore, DatalinkII version 3.4 would be a more

recent

AN
AN

version than Datalinkl version 5.5.
NOTE: The following instructions update existing versions of DatalinkII software.

During the program installation (step 7), select the unit to be utilized. Be sure to select
“SmartWire”, as this will install the necessary files needed for the SmartWire unit.

To install the software

A S R e

—
=]

1.
12.
13.
14.
15.

Upon completion of installation, a new shortcut icon (shown right) will be added to the PC desktop Eb
with a title “DatalinkIl Program”. Double click on the icon to start the DatalinkII software. L 2

Close all/any programs before beginning the DatalinkII installation

Insert DatalinkIl CD into CD/DVD drive of PC and close bay door

After a few seconds, the installation program should automatically start

“Welcome to the Install Wizard for DatalinkII”. Click Next

“License Agreement”. after reading, Click Yes

“Choose Destination Location” Default C:\Program Files\DatalinkIl, Click Next

“Data Logger Installation and Support”, Select the check box for SmartWire, Click Next
“Select Program Folder”, Default is DatalinkIl, Click Next

Install will start as noted by progress bar

. If install for the first time, a “Welcome to the Install Wizard for PL-2303 USB-to-Serial” window

will open, Click Next

“License Agreement”, after reading, Click YES
Installation PL-2303 Wizard Complete, Click Finish
Installation Wizard Complete, Click Finish
DatalinkII will now open

Software Installation Complete

Datalink
Prograrm

Racepak
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Configuration Files

The SmartWire unit is shipped from Racepak, with factory default settings. The end user must program the
SmartWire for each particular application and wiring termination. To modify the settings of the SmartWire unit,
a PC/laptop must be connected to the SmartWire in one of the two fashions shown below. A configuration file
on the PC/laptop will then be opened and synced (READ from) the unit. Once the settings are read from the
SmartWire, changes are made, and SENT/WRITE back to the SmartWire.

Stand Alone or with V-Net sensors, No Data Recorder

When utilizing the SmartWire as a standalone system (i.e. not connected via V-Net to a compatible Racepak
Data Recorder), the factory car configuration file was copied onto the PC during the DatalinkIl software
installation, and will be listed as SmartWire Config. The configuration file contains the setup information for
the SmartWire unit, and each of the internal channels connected to the SmartWire unit.
Use this file to modify the setup of the SmartWire or to view real time data.

1. Connect PC to SmartWire unit using the USB programming cable supplied with
SmartWire unit system. The programming port is located next to the status lights
on the SmartWire unit (shown right).
2. Ensure the main power is turned on for the SmartWire. The Power light will be on
and lit Red when power is on. m
3. Start the DatalinkII program by double clicking on the DatalinkII Program icon located
on the Windows desktop of PC (shown right). E?utgarL.ia?E
4. Open the car configuration file. To open the car configuration file, select File
located in the main menu bar across the top of the screen and select Open Car
Configuration. (shown right).
5. The dialog box (shown right) will be displayed x|
6. The list on the left-hand side of the Select + N
Configuration dialog box will display all of the file
folders in the RacePakData subdirectory J c
(C:\RacePakData) that contain valid configuration e | [ o]
files with a .rcg file extension. Select the SmartWire
listing by selecting with the cursor.
7. The list on the right will now contain the list of configuration files contained in this folder. The factory

configuration file for the SmartWire unit will be located here. Select the OK button

Racepak
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SmartWire with Data Recorder

If utilizing the SmartWire unit with any of the compatible Racepak Data Recorders (i.e. connected via V-Net to
compatible Racepak data recorders), the same car configuration file utilized to program the data recorder will be
also be utilized to program the SmartWire. The SmartWire will need to be synced into the existing car
configuration file. Once READ in (synced), channel buttons for the SmartWire unit will appear in the data
recorder configuration file.

1. Connect PC to data recorder using the programming cable supplied with data

recorder system. f—=%
o S
2. Ensure the main power is turned on for both the SmartWire A/ND data recorder.
The Power light on the SmartWire should be lit Red.
3. Start the DatalinkIl program by double clicking on the DatalinkII EEJ:D
Program icon located on the Windows desktop of PC. E?Dtga}é'?ﬁ

Cigse: CLrl+C
Chrl+5

4. Open the car configuration file. To open the car configuration file, select File

located in the main menu bar across the top of the screen, and select Open

Car Configuration. (shown right).

5. The dialog box shown below will be displayed. Sra e

6. The list on the left-hand side of the Select Configuration dialog

Smarthire ;I
box will display all of the file folders in the RacePakData

subdirectory (C:\RacePakData) that contain valid configuration files

with a .rcg file extension. Select the item that matches data

recorders serial number by left clicking on it with the mouse

(shown in example is V300SD_4447).

7. The list on the right will now show the list of configuration files contained in this folder. Select the item

which matches the data recorder serial number by left clicking, then the OK button.

Racepak
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General Reading and Sending/Writing Configuration File Settings

When connected to the PC, there is not a continuous communication between the SmartWire and PC
configuration file. Communication is only during Reading and Sending commands. It is best to open a
configuration file and perform a global Read command to insure the settings viewed on the PC are currently
programmed in the SmartWire. To perform this global read command,

1
2
3.
4

W

. Open the Car Configuration as shown in the previous sections

Select Edit from the menu task bar located at the top of the screen

Select Read V-Net Config or select the Read button from the toolbar Read |

. A message log window will open and start scrolling indicating the reading is in process from the

system
When the message dialog box reads “DEVICES READ SUCCESSFULLY?”, click OK
Select File from the menu task bar located at the top of the screen

Click Save to save these current settings to the configuration file.

At this time, it is possible to modify the settings and send updates to the SmartWire. Each window has a Send

Configuration button. This will send just the opened windows parameters.

1.

To Send the entire configuration file to the SmartWire, select Edit from the menu task bar located at

the top of the screen

Select Write V-Net Config or select the Write button from the toolbar Wwrite

After any changes, periodically save the configuration file to ensure it stays in sync for offline

viewing.

General Modifying of SmartWire Programming
To modify the SmartWire setup, perform the following steps:

A T o

Connect PC to Racepak unit using one of the previously mentioned methods
Apply power to unit

Start the DatalinkII program on PC and open the appropriate car configuration file
Select the device/channel to be modified

Make the desired modifications to the device/channel

SEND/WRITE the modified configuration to the device

Save the modified car configuration file

Racepak
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SmartWire Programming

Using the previous instructions, it is now time to begin programming / configuration of the SmartWire unit. The
following general steps are performed to setup input channels, setup the output channels and program the logic
for the output channels to enable the output to perform its intended purpose.

1. Select the INPUT channel to be program

Configure the input channel for its intended purpose and Send these settings to the SmartWire
Select the OUTPUT channel to be program

Configure the output for its intended device and Send these settings to the SmartWire

2
3.
4.
5. Configure the outputs ON CONDITIONS and LOGIC for proper control of the device and Send

these settings to the SmartWire

6. SAVE the updated car configuration file on the PC

The following pages will describe each window within the SmartWire configuration file. Using the Hardware
Installation Manual AND the Software/Programming Manual, along with using the previously mentioned
instructions, should provide a better understanding of the steps of installing and programming the SmartWire
unit.

At this point it would be best to have a generalized plan for the outputs and inputs of the SmartWire system.
This plan should include the following steps:

1. What will be connected and used as the inputs (switches/buttons)?
e Starter button, Ign. switch, Light switch, Fuel Pump, Fan, Water Pump, etc.

2. What will the outputs connect to (devices)?
e Starter Solenoid, Ignition system, ECU, Lights, Fuel Pump, Fans, Water Pump, etc.

3. What Conditions/Logic will be used to control the outputs?

Starter button for Starter Solenoid activation

Ignition switch to turn on Ignition system, ECU, and Fuel Pump
Light Switch to turn on all Lights

Cooling Switch to turn on Fans and Water Pump

Allow ample time to program and wire the SmartWire.

It is recommended to initially install the Main Power and Ground wires first in order to program
& each input and output. Once programmed, terminate and wire only the necessary connections. Do
not terminate every connection, unless a device will be connected.

To get the most out of the Racepak SmartWire unit, it is highly recommended to thoroughly read the
entire manual before installation and use of the Racepak SmartWire unit. In addition, test the
SmartWire unit and settings/functions before use. The race track is not the place to determine something
is not working properly!

Racepak
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General SmartWire Unit Overview

Two 23 Pin Amp connectors for:

Thirty Outputs: Output to all vehicle devices requiring switched power
Twelve Hardwired Direct Inputs: Inputs from switches and buttons

Three SmartWire Ground: Main grounding for SmartWire unit

One Shutdown Pin: Main power shutdown for SmartWire when grounded

\ \
] [[H

Main Stud:
Main power for SmartWire
from battery ® | ®
11.5 volts minimum for \ . | .
typically operating THl
USB Programming Port:
Used for programming when no V-Net
data recorder is connected.
Note: Not used when SmartWire is
utilized with a V-Net Data recorder.
Programming will then be performed
% H H H E H HH HUAD through the data recorder.
@25) ° =
Switch Port: :\I @ . %
Connection for External Switch .
Panels/Modules if utilized \ Lights:
Power:
V-Net Port: e Red when powered
Connection for V-Net Status:
devices if utilized e  Green when no fuses are blown
e Red when a fuse is blown
Power Light Status Light
No Power' O off O off
Powered on with no issues, Normal @ Solid Red ® Solid Green
Powered on with a Blown Fuse’ @ Solid Red @ Solid Red
Firmware Update in progress @ Solid Green @ Solid Green
Firmware Update failure # Flashine Red O off

"No power could be due to no power at main stud, no ground to main unit, or Shutdown pin is grounded.

2 . .
Blown fuse on one or more circuits

NOTE: The SmartWire is designed as a switching control unit. The SmartWire unit is not
designed as a main power feed for certain high current items. These items include, but not limited
to ignition and electronic fuel systems. Refer to device manual for power requirements.

& If the manufacturer recommends the main power be connected to the main direct battery power,
follow the manufacturer’s requirement and DO NOT connect items through the SmartWire.

Racepak
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Configuration File (setup file)

Viewed by opening the car configuration file by one of the below methods:
e Standalone —File->Open Car Configuration—>SmartWire—>Click OK
e Via Data Recorder — File->Open Car Configuration—> The data recorder—=> Click OK

& NOTE: When via Data Recorder, the SmartWire channels will only appear after the SmartWire
has been connected and synced up with the data recorder by performing a Read V-Net Config.

NOTE: If optional Switch Panel and/or Switch Module is installed, a separate channel, for each,
may appear with what is shown below. See Switch Panel Section for programming details.

=10l x|
File Edit Telemetry Runlog Track Map View Settings Security Help
0 || % Graph & Smartwire |
Q|| [smartWire 1 |Wis  [SW1 Output#s | IS N/S N/S
= || [SM1Output#1 | WS [SM1Output#d | WIS /S N/S
W || [SM10Output#2 |W/S  [SM1Output#10 | NiS NIS N/S
@ || [SM1Output#3  |W/S  [SM1 Output#11 | Nis NIS N/S
Read || [SM1 Output#4 | N/S [ SM1 Output #12 | WIS /S N/S
write || [SM1 Output# | NIS [ SM1 Output #13 | NIS NIS N/S
& || [sM1 Output# |N/S  [SM1 Output#14 | NIS NIS N/S
[SM1Output#7 | N/S  [SM1 Output#15 | Nis /S N/S
B
7 |1 | ¥

Next to the graph tab, a tab appears with a blue wrench. This blue wrench designates the configuration file tab.
Listed below the configuration tab are the buttons for each of the channels on the SmartWire unit.

Channel buttons:
By right-clicking on each channel button, the channel settings for that particular channel are available.

[SmartwWire 81 ] martWire#1: Channel button to access the SmartWire main unit system settings (SmartWire
Parameters)

[t Output#1_Jg vy Output #1 — SM1 Output #30: Output channels 1-30. Each of these buttons accesses the
channel settings for each SmartWire output. See inside back cover for pin locations on main connectors.

[sw1 switches  JSM1 Switches: Hardwired input switches to SmartWire unit, input channels 1-12. This channel
button contains the settings for each of the 12 input connections to the SmartWire. See inside back cover for pin
locations on main connectors.

Racepak
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SmartWire Main Unit Settings
Accessed by right-clicking on the main

SmartWire channel button

e Device Name: Name of SmartWire unit.

Default=SmartWire #1

e Type: Device Type Non-programmable

e VNet Update Rate: Sample rate of the broadcast of this channel out to other devices/channels on the V-
Net. Default=20

e VNET ID: ID of the broadcast of this channel out to other devices/channels on the V-Net. DO NOT
CHANGE-FOR ADVANCED USERS ONLY!

e Switch Bus Update Rate: Sample rate of the broadcast between SmartWire unit and items connected to
the switch port on the SmartWire unit. Default=10

e Logger Sample Rate: Logging sample rate of this channels when used with a Racepak data logger.
Default=20

e Unit Serial #: Serial Number of SmartWire unit. Non-programmable

¢ Firmware Version: SmartWire unit internal software version (see firmware update section for details)

e SmartWire Device Number: SmartWire device number. Used when multiple SmartWire units are
installed in same vehicle Default=1 (changing this number will reset unit to factory settings)

e VNET Bus Terminating Resistor: Each end of the V-Net bus must be terminated. This setting allows
the user to either enable or disable the internal resistor. Default=0ff DO NOT CHANGE-FOR
ADVANCED USERS ONLY!

e Switch Bus Terminating Resistor: Each end of the Switch bus must be terminated. This setting allows
the user to either enable or disable the internal resistor. Default=0On DO NOT CHANGE-FOR
ADVANCED USERS ONLY!

e Supply VNET Bus Power When: This setting is used to manage if/when the V-Net system receives
power from the SmartWire unit. This manages the power to the items connected to the V-Net port on the

SmartWire unit. Default=Always On

Racepak
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e Supply Switch Bus Power When: This setting is used to manage if/when the switch port receives
power from the SmartWire unit. This manages the power to the items connected to the switch port on
the SmartWire unit. Default= Always On

e VNET Bus Gateway: Default=0On DO NOT CHANGE-FOR ADVANCED USERS ONLY!

e Internal Temp Units: Determines unit of measure for the internal temperature sensor when logged.
Default="°"F

¢ Real-Time Telemetering Setup (Graph View): To perform a Real-Time graphing, channels must be
selected and sent to the SmartWire unit using the Real-Time Telemetering Setup windows. (See Real-

Time Viewing section)

Buttons (lower right of window):
e Start All Channels Live Data (List View): When a real-time graph is not required, this button can be

selected to show a real-time list of channels. Shows SmartWire outputs and hardwired inputs only.
e Start Channel Live Data: Shows real-time data for this one particular window.
¢ Send Configuration: Sends the windows current values of this channel to the SmartWire
e Read Configuration: Reads the values from the SmartWire and populates the window with the

currently programmed values of this channel.

Racepak
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Outputs (channels 1-30)
Accessed by right-clicking on the SM1- ~ Su=SEEEEAaasss

. Chiaricl Nare: ype: [SHARTVIE 208
SM30 output channel button (Refer to channel/pin chart e = \net 0 [smartire =1 w130 B
on last page Of thls manual) Unit Serial % | 600000 Oub:utFunchunr|Cnnstant0n :]
stk Moo L Missing VNET Message Logic: [Condition False =
Fuse Current: | 10 [0.5 to 30] Amps Logger Ssmple Rate: [50 =l
e Channel Name: Can be changed to match the R E
Current Graph Max: | 35 1 _,:‘ Smoothing VNet Update Rate: | 50 T
device this output is connected to for ease of il O Rk mieloF]
p Valts Graph Max: | 35 1 _,Zii Smoothing On Delay Time; | 0 [0 to 65] Seconds
future programming. It iS recommended tO Start Fuse ResetDelay: | 2 [0 4o 65] Seconds: Off Delay Time: | 0 [0 to &5] Seconds
Max Fuss Retries: | 100 [0 o 65535] Pulse Time: | 0 [0 to 65] Seconds
. {ash Op Time: | 0.5 o. 5] Seconds
the name with a reference to the channel number R
(ex: output #12 for Fuel Pump = “O12 Fuel e

Start Real-Time Display | READ Configuration |

Cancel

Pump”’). Name must start with a letter.
Default=SM1 Output #n

o Type: SMARTWIRE 204 or SMARTWIRE 104 Designates the particular channel type. Device
connected to this channel should not exceed the listed current rating. Non-programmable

e Channel Mode: Enabled or Disabled, designates channel output mode Default=Enabled

e Vnet ID: ID of the broadcast of this channel out to other devices/channels on the V-Net.
DO NOT CHANGE-FOR ADVANCED USERS

e Unit Serial #: Serial number of the SmartWire unit this output pertains to.

¢ Output Function: Constant On, Flash, Latch On, Single Pulse, Windshield Wiper; Default=Constant

On

o Constant On: When on condition is met (true), output will remain on until on condition is not

met (false). On/Off Delay times are active when selected.

o Flash: When on condition is met (true), output will flash on/off until on condition is not met

(false). On/Off Delay times and Flash On/Off times are active when selected.

o Latch On: When on condition is met (true), output will latch (lock) on and remain on regardless

of on condition (true or false). In order to reset, master power must be cycled to off position. On

Delay time is active when selected.

o Single Pulse: When on condition is met (true), output will activate once regardless of condition.

On Delay and Pulse Time is active. Once Pulse Time is finished, condition must go false in order

to restart output on next true condition.
NOTE: Once activated, the output will run through the cycle regardless of the on-condition.

Output is active once on-condition is met regardless how long the on condition remains true.

Racepak
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o Windshield Wiper: Only available on output channel 19 (pin A17). Allows a direct method to
be utilized for windshield wiper motor/parking operation. When a direct method is used, a
reference channel named Wiper Brake Control Channel becomes selectable. An input channel
must be selected in order to Park the wipers in the correct location. This is the channel that will
be the input referenced for the Park position. See SmartWire Installation manual for further
details.
Output Number: Designates the output channel number (not actual pin/connection number)
Missing VNET Message Logic: Designates the condition for any of the Setpoint Control Channels,
used in this particular channels operation, should they become inactive/missing on the VNET CAN bus.
Example: A water temp sensor is used in the logic to turn on/off this output to control a fan. When the
water temp goes above 180F, the condition for this would go True, therefore making the fan output
condition True and the fan would turn on. If by chance, this water temp sensor module becomes
inactive/unplugged at any time then the “Missing VNet Message Logic” setting will be referenced for
this channel. In a case where the water temp sensor module becomes inactive/unplugged, if set to
“Condition True” this would turn the fan on. If set to “Condition False” the fan would never turn and
overheating will occur. Default=Condition False
NOTE: For critical controlled items, a range check should be performed on any input channel
(sensor) associated with the output. This range should be taken into consideration when

programmed into the True/False settings, to ensure the output will be in a non-problematic

state should the input channel (sensor) fail or go outside its operating range.

Fuse Current: Fuse value, this is the max current that is allowed before fuse is blown (output off).
Higher numbers than the channel output are possible only for surge (momentary) times. Default=20 on
20 amp Type, 15 on 10 amp Type.

Logger Sample Rate: Logging sample rate of this channels when used with a Racepak data logger.
Default=off

Current Graph Min: Minimum graph scaling for the Current (Amp) Y axis of this channel. Pertains
only to logging of this channel. Default=0

Current Graph Max: Maximum graph scaling for the Current (Amp) Y axis of this channel. Pertains
only to logging of this channel. Default=35

Volts Graph Min: Minimum graph scaling for the Volts Y axis of this channel. Pertains only to logging
of this channel. Default=0

Racepak
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Volts Graph Max: Maximum graph scaling for the Volts Y axis of this channel. Pertains only to
logging of this channel. Default=35

Fuse Reset Delay: Number of seconds between blown fuse and resetting of the fuse. Default=2

Max Fuse Retries: Number of times the system will try to reset a blown fuse. Default=100VNet
Update Rate: Sample rate of the broadcast of this channel out to other devices/channels on the V-Net.
Default=10

Switch Bus Update Rate: Sample rate of the broadcast between this channel and items connected to the
switch port on the SmartWire unit. Default=10

On Delay Time: Once the condition is true, this is the amount of delay before output becomes active.
Default=0

Off Delay Time: Once a true condition goes false, this is the amount of delay before the output becomes
inactive. Only shown when Output Function set to Constant On or Flash Default=0

Flash On Time: Once the condition is true and the On Delay Time is finished, this is the amount of time
the output will be active. Once this time is finished, the Flash Off Time becomes active. Only shown
when Output Function set to Flash Default=0.5

Flash Off Time: Once the Flash On Time is finished, this is the amount of time the output will be
inactive. Once this time is finished, the Flash On Time becomes active. Only shown when Output
Function set to Flash Default=0.5

Pulse Time: Once the condition is true and the On Delay Time is finished, this is the amount of time the

output will be active. Only shown when Output Function set to Pulse

Buttons (lower right of window):

On Condition: Shows the On/Off Conditions logic window for this channel

Start Channel Live Data: Starts the Real-Time window for this channel

Send Configuration: Sends the windows current values of this channel to the SmartWire
Read Configuration: Reads the values from the SmartWire and populates the window with the

currently programmed values of this channel.
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On/Off Conditions for Outputs

[ oncndin | Accessed by clicking the On Condition button within any of the Output channel windows.

x
° Setpoint Control Channel: The pull_ = —— o [L0SIC lcearor e b Riht ik o o o renove condrs——
ondition | Delay Delay
. 1. [smartwire #1-Temp (x11e] 7| [Equal to = [0 [
down boxes #1-#10 allow selection of | e e— o
(1. Smartiire#1 - Temp = 1) &
channels, which are used to reference TS| T o —
4. [~Disabled= (x0) =] |[Equal 0 | [e [
for On/Off conditions of this output. T — T — o -
. 5. [Disabled= (x0) = |[Faual o | [0 ,u_
Channel name and its ID number are [ SlEms 3 o o
8. [~Disabled= (0) = |[Faeal o | [0 o |
Shown 5, [-Disatied= (0) =] |[Equal 0 =] [o o
10. [ =Disabled= (x0) =|[faeo = [o I

e Operation: Not Equal To, Equal To, —

Greater than, Greater than or Equal to,
Less than, Less than or Equal to Operators used for status of the Setpoint channel
e True Condition:
o Not Equal To, Equal To - Value used for the Setpoint Channel to be True.
o Greater than, Greater than or Equal to, Less than, Less than or Equal to — Value used for the
Setpoint Channel to become True. Requires a False condition to be set (*Hysteresis)
e False Condition
o Not Equal To, Equal To - Value used for the Setpoint Channel to be False.
o Greater than, Greater than or Equal to, Less than, Less than or Equal to — Value used for the

Setpoint Channel to become False. Requires a False condition to be set (*Hysteresis)

*Hysteresis —When the Greater than, Greater than or Equal to, Less than, Less than or Equal to is
selected, both a True and False condition must be entered. To prevent oscillation and/or chattering (i.e.
undesirable rapid changes between the two condition states, True or False), a small difference between
the True and False is required. Depending on the channel and desired condition, this difference can
either be small or large. If the difference is too small, this can cause the output channel to turn on/off
rapidly, causing undesirable effects. A larger difference in set points prevents chattering of the output

channel.
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» Greater than, Greater than or Equal to, requires a higher true condition value vs. false condition value

» Less than, Less than or Equal to, requires a lower true condition value vs. false condition value

0On /Off Conditions for Cooling Fan

Setpoint Contral Channel

False
Condition

| 160

Operation True
Condition

IGreater than j I 150

1. |Water Temp (x203) |

Example: A water temp sensor is used in the logic to turn on/off this output to control a fan. When the
water temp goes above 180F, the condition for this would go True, therefore making the fan output
condition True and the fan turns on. Of course with the fan on, the temperature will start to drop below
the 180F setting therefore shutting the fan off. In this instance, the fan would toggle on/off at this
temperature. To keep this toggle effect from happening, a lower shutoff value should be used such as

160F (example shown).

f NOTE: For critical controlled items, a range check should be performed on any input channel
(sensor) associated with the output. This range should be taken into consideration when
programmed into the True/False settings. This will ensure that the output will be in a non-

problematic state should the input channel (sensor) fail or go outside of its operating range.

e True Delay: Once the Setpoint channel true condition is met, a time delay can be entered before it is
evaluated by the channel logic as True, thus controlling the output channel.

e False Delay: Once the Setpoint channel false condition is met, a time delay can be entered before it is
evaluated by the channel logic as False, thus controlling the output channel.

e Logic Area: This area to the right of the On/Off Conditions window is where the output channel logic is
entered. By right clicking in this area, select the enabled Setpoint Control Channels and their conditions

for use in the AND / OR logic to control the status of the channel output.
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Setpoint Control Channel
When selecting SmartWire outputs (as opposed to inputs and V-Net inputs) for the e —
Setpoint Control Channel, the following options are presented: N ST —( ||
e Current- shown as the main channel name next to the + sign z ::5?.153”1“2,“5;4’;’{’”_‘%95mﬂj'_

| -sMioutput#1-Statusxabo [T
SM1Cutput #2x1b1
(- 5M1 Output #3 x1b2 _—

* | 1-SM1 Output #4x1b3 |

e Status- shown below Voltage .

e Voltage-shown below main channel name after the + is selected

In the example shown on right, the main channel name (SM1 Output #1 x1b0) is the Current (Amp) value.
By clicking the + sign next to the channel, the channel Voltage or channel Status can be selected.

Name Description | Values

Channel Name Current Output current in Amps, Resolution 0.5 Amps
Channel Name - Voltage | Voltage Voltage on output, Resolution 0.1 volts
Channel Name - Status Status 8 bit mask, see channel status below

Channel Status Bit Mask 1

Bit Value | Status Description

0 1 ON/OFF Bit set when output is on.

1 2 ON DELAY Bit set when output is waiting for On Delay Time to expire before turning on.

2 4 OFF DELAY Bit set when output is waiting for Off Delay Time to expire before turning off.

3 8 LATCHED ON Bit is set when output is latched on. Only possible when Output Function is set to Latch On.
4 16 NOT USED Open for future use.

5 32 NOT USED Open for future use.

6 64 RETRY LIMIT Bit sent when Max. Fuse Retries setting is reached.

7 128 FUSE BLOWN Bit set when output fuse is blown because the Fuse Current setting has been exceeded.

Channel Status Values

The status bit values are additive. Fore instance, during a delay off Value Output Status
condition the Status will be 5 since the output is ON (value 1) and the 0 Off
OFF DELAY (value 4) bit is set. ! On
2 Delay On

. . . . 5 Delay Off
NOTE: Once the logic area is completed, click OK and click the Send 9 Latched On
Configuration button to send these changes to the main SmartWire 128 Blown Fuse
module. Be sure to save the updated configuration file. 192 Blown Fuse, Retry Exceeded
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Logic Example

The example below is for an output connected to a Fuel Pump. An Oil Pressure sensor is installed via V-Net.
The Ignition Switch, Fuel Pump Switch and MSD 2 Switch are connected via the Switch Panel. The example
shows;

Turn on the output channel (Fuel Pump) when the following conditions are True:
e Qil Press is above 10psi (greater than 10) “&” Ignition Switch is on (equal to 1) “OR” Fuel Pump

Switch is on (equal to 1)

This would turn the pump on anytime the engine has oil pressure “&” the ignition switch is on “OR” the Fuel
Pump Switch is on (equal to 1)

The Fuel Pump would turn on if the fuel pump toggle switch was turned on (True) regardless of any other
conditions. This could be viewed as a “force on” switch possibly used for priming.

The “&” value connects two logic conditions together meaning both would have to be True in order for the
output channel (Fuel Pump) to be activated.

The “OR” value separates the logic conditions. If ANY of the logic conditions are True, the output channel
(Fuel Pump) would be activated and remain on until all logics are False.

NOTE: There is one Setpoint Control Channel (MSD 2 Switch) that is enabled, but not used anywhere in the
logic area; therefore this Setpoint Control Channel will not affect anything on this output channel.

All logic conditions are added/removed by right clicking in the Logic area.

On [ Off Conditions for Fuel Pump

LOGIC - Place cursor inside box and Right-Click to add or remove conditions

Setpoint Contral Channel Cperation True Falze True Falze
Condition | | Condition | Delay Delay
;X |Di| Press (x204) :I |Greater than ;I I 10 | 5 | |
(1, Oil P 10) & (2 Ignition Switch =1} &
9 IIgnjt'on Switch {(x118c) LI IEquaI to j I 1 | i | | e A =He
3 |Fuel Pump Switch (x418c) :I |Equa|b3 :I I 1 | 1 | I
[OR]
4 |50 2 switch (x618c) || |Equal to | E | |
5, |=Disabled= (%) ;I IEquaI to j I i | i | | (3. Fusl Pump Switch = 1) &
6. |=Disabled= {x0) LI |Equa|b3 j I 1 | 1 | I
7. |=Disabled= {x0) Ll |Equa|t0 ;I I i | | I [OR}
8. |=Disabled= (x0) j |Equal to :I I 1 | 1 | |
g, |=Disabled= (x0) ;I |Equalm j I 1 | 1 | I
18: |=Disabled= () LI IEquaIto LI Il | 1 | |

CK I Cancel
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Input Switches - Hardwired Direct

Accessed by right-clicking on the SM 1 . po—
anned Mame: | SM1 Inputs Sutch  Pin#  Name e
. 1 A0 [ w [Ground Trigger _~]
Output channel button (Refer to channel/pin chart for eS| 2w prew e leets
3 Al SECEE] [Ground Trigger =]
wiring on last page of this manual)) P Rk g
6 A4 [SMiSw#s [Ground Trigger |
Type: [SARTHRESWIR 7. B0 [SH1 S tt7 [Ground Trigger _+]
g Bl [SHiT S tiE [ Ground Trigger =]
. a g2 [ w [Ground Trigger =]
e Channel Name: Main channel name for the 12 st BT o m P g leets
1. B [SHiT 5w i1 [ Ground Trigger ~]
Hardwired Switched Inputs. Change only if more e me [z [Brnd Tigsn =]

Smartwire Switches Parameters

SEND Configuration ‘ Ok ‘

than one main SmartWire module is on the

Start Real-Tme Displayi|  READ Configuration ‘ Cancel ‘

vehicle. Default=SM1 Inputs, User- programmable
Vnet ID: Broadcast ID of this channel out to other devices/channels on the V-Net. Requires a change
only if more than one SmartWire unit is installed on vehicle. Default=SmartWire 1 Switches x190, DO

NOT CHANGE-FOR ADVANCED USERS ONLY!

Logger Sample Rate: Logging sample rate of this channels when used with a Racepak data logger.

Default=50

Type: Device Type

Unit Serial Number: Serial Number of SmartWire unit

Individual Switches: Programming area for the 12 Hardwired Switched Inputs

o Switch Number: Designates the input channel number (not actual pin/connection number)

o Pin Number: Physical pin/connection number for the each switch input. This number refers to the
pin location in each of the two main SmartWire Connections A or B.

o Name Channel names for each of the 12 Hardwired Switched Inputs. Can be changed to match the
device this switch or input is controlling. It is recommended to start the name with a reference to the
type (ex: Hardwired Direct Input #2 for Fuel Pump = “HDIN#2 Fuel Pump”). Name must start with
a letter. Default=SM1 Sw #n

o Trigger Level: Designates if this input is to be Ground Triggered or Voltage Triggered to be True.
o Ground Trigger: Input is triggered/active when the input is grounded.

o Voltage Trigger: Input is triggered/active when the it has a voltage above 2.8v applied.

Buttons (lower right of window):

Start Real-Time Display: Shows real-time data for this one particular window.
Send Configuration: Sends the windows current values of this channel to the SmartWire
Read Configuration: Reads the values from the SmartWire and populates the window with the
currently programmed values of this channel.
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Input Switches - Smart Panel or Smart Module

Accessed by right-clicking on the SP1Switches channel button (optional, sold separately)

& NOTE: The Switch Panel will need to be added to the configuration by performing a Read V-
Net Configuration before the SP1 Switches channel button appears.

[ Toggle Switch Panel x|

Switch Panel Name: | 5P es Unit Serial :{ 93 Type: | TOGGLE_SWITCH_PANEL
et I0: [Snitches Panel #1 x18C B =

E

SW Fan [sw Trans cooler [sw ace [sw tionts
8 ~| [switch on x0 =] [switch on x0 =] [switch o xo =] fswitch on x0 =] [switch on x0 =] [switch on x0 =]

RNING: Turns enfoff the bus termnating resistor inside the snitch panel,
SHOLLD BE TURNED ON OFLY FOR LAST SWITCH PANEL IN LINE,
Switeh Bus Terminating Resistar: | ON -

e Switch Panel Name: Channel name for the Switch Panel (optional, sold separately). Change only if
more than one Switch Panel is connected to one SmartWire module. Default=SP1 Switches
o Unit Serial# Serial Number of Switch Panel unit, Non- programmable
e Type: Device Type, Non- programmable
e Vnet ID: V-Net ID for the Switch Panel. Change only if more than one Switch Panel is connected to
one SmartWire module. Default=SmartWire 1 Switches x190
e Logger Sample Rate: Logging sample rate of this channels when used with a Racepak data logger.
Default=20
e Switch Names: Name of each switch. Can be changed to match the function of each switch. It is
recommended to start the name with a reference to the type (ex: Switch Panel Input #2 for Ignition =
“SP#2 Ignition”). Name must start with a letter. Keep in mind each switch can have multiple
functions/outputs due its ability to be used in multiple output control logic windows.
Example; one switch can turn on multiple items (outputs) such as fuel pumps, ignition system
together along with other outputs of the SmartWire with one flip of the switch. This along with other

logic and Time Delay features can be used to stagger outputs with other inputs/outputs.
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Status IDs: The Status ID represents action of the LED lights above the toggle switches. The Status ID
can be used to simply monitor the status of the toggle switch (Switch On x0) or to indicate the status of
any selected output by selecting the channel in the pull-down menu desired to monitor. The Status ID
can monitor any selected output channel, regardless of the output channel the switch actually controls.

o No Light - indicates output channel is off

o Green Light - indicates output is on with no delays or blown fuses

o Orange Light - indicates output has a delay in effect, either waiting to turn on, or waiting to turn

off.
o Red Light - indicates a blown fuse.

NOTE: The Status ID is not selectable for the push button light. This light has two functions:
1.  Shows the operation of the push button (no light off, green light when pushed)

2. Shows switch panel has power by a green blink approximately every 4 seconds.

Switch Bus Terminating Resistor: Determines if the switch panel is internally terminated. Terminating
resistor should be ON if one switch panel is installed. If more than one switch panel is installed, the last
switch panel should have the terminating resistor turned on, all others should be turned OFF. The
SmartWire unit has a setting for its Terminating resistor that needs to be turned ON and the last Switch

Panel or Switch Module should have its Terminating resistor turned ON.

Buttons (lower right of window):

Start Real-Time Display: Shows real-time data for this one particular window.
Send Configuration: Sends the windows current values of this channel to the SmartWire
Read Configuration: Reads the values from the SmartWire and populates the window with the

currently programmed values of this channel.
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Real Time Viewing

The SmartWire has three types of real-time viewing options. To view any of these:

24

'

1. Connect the PC to the SmartWire unit either directly using the USB programming cable OR through a
compatible Racepak data recorder using its programming cable.

Start the DatalinkIl program on the PC

AU

Refer to 1 of the 3 below Real-Time options

1-Start All Channels Live Datq >=* chennsstive bata |

SmartWire #1

button.

This window shows a list of all channels within the
main SmartWire unit. For diagnostic reasons,
channel number, channel name and the pin number
are shown.

Current column is the channels Current (Amp) in live
time.

Voltage column is the channels Voltage (Volts) in
live time. This is the voltage on the output and
indicates the power at the connector for this pin.
Assuming there are no connection issues between
this pin on the connector and the device this pin is
connected to, the device should be powered on.

Status column simply show the outputs current status
(On/OfY).

Ensure main power is on for the SmartWire (power light on SmartWire is solid red)

Open the car configuration file for the SmartWire File=>Open Car Configuration->SmartWire
Right click the channel button for the channel wished to view

All Channels Real-Time Display

|
|

E

}éﬁﬁ

Eg

E

}éﬁi

Eg

ol e e =

4
1

E
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. Output

11. 5M1 Ouftput #11

12. 5M1 Ouftput #12

13. 5M1 Ouftput #13

14. SM1 Ouitput #14

15. 5M1 Ouftput #15

16. 5M1 Output #16

17. 5M1 Ouftput #17

18. 5M1 Ouftput #18

19. 5M1 Ouftput #19

20. SM1 Output #20

21. SM1 Output #21

22. SM1 Output #22

23. SM1 Output #23

24. SM1 Output #24

25. SM1 Output #25

26. SM1 Output #26

27. SM1 Output #27

28. SM1 Output #28

29. SM1 Output #29

30. SM1 Output #30

B23

0.0

0.1 - Off

:l1]2]3]|4|5|6l7]8]|9]10l11

o
E
i e e e o e e e o e e e e e e e e B e o

Available in the main SmartWire window accessed by right-clicking on the SmartWire channel

| 12|

SM1 Ii

Stop Real-Time Display I

Exit

On column can be clicked on/off to force this channel active.

Located in the bottom row are on/off status for each of the Hardwired Direct Input Switches 1-12. If any input
switch is activated (physically activating the switch/button connected to the particular channel), a green dot will
appear in the box located below its channel number listing (Switch: 1-12).

Ensure it is safe to activate the channel. Once clicked, this output channel will be active until clicked
& off. (Example: Should the Engine Starter output channel be selected the starter will activate and

continue to be on until channel is clicked off)
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Z-Sta]"t Channel Live Data Start Channel Live Data |
Available in all SmartWire channel windows.

By clicking the Start Channel Live Data button, the live values for the currently opened window will appear.

‘Device Name: | smartviire #1 Type: [SMARTWIRE USB
Main SmartWire e — o C—

Window shows: o v P [ S
|

e || | ’
e Voltage at Main power Stud e

Real-Time Telemetering Setup,

e Internal Temperature of SmartWire P

partcpat

e Number of Blown Fuses

Current/Voltage Output Parameters x|

Channel Neme: [ 51 output #1 Type: [ SMARTWIRE 204
ChemnelMode: [Enbed =] VnetD: [Smartire #1 x180 -
Olltp ut Channels Untserial #: 600000 Qutput Function: [Constant on |
Output Number. 1 Missing VNET Message Logic: |Condition False hd
. Fuse Current: | 20 [0.5 to 30] Amps Logger Sample Rate: [Logging Disabled =
Window shows: e
Current Graph Max: | 35 1 _,::' Smoothing VNet Update Rate: [10 =
Volts Graph Min: |0 Switch Bus Update Rate: | 10 -
e Current: Amperage on channel o [ [T ] snaoes B T

Fuse ResetDelay: | 1 [0 to 65] Seconds Off Delay Time: | 0 [0 to 65] Seconds
Max Fuse Retries: | 100 [0 to 65535] Real-Time Channel Yalues

e Voltage: Volts on channel Curent | oltage | staus

00 | 003 | off |
e Status: status (On/Off) e | | |
Pin Number: A3 Stop Real-Time Display I READ Configuration | Gancel I

Smartire Inputs Parameters x|

ChemelName: [SM1Inputs

it et pme T
Q1 A0 [wiswar [Grot |

Vnet ID: [Smartiire 1Switches x190 =] (|02 A [smiswm [Grot i

. . . O3 A [isem [Ground Trgger =]
Hardwired Direct Input Switches ou w [EEE e
e 05 a5 e [GomaTrsser =]

. O6 Au  [uiswss [Ground Trazer =]
Window shows: e |07 W Fw oo ]
08 B [wiswrs 6 =

Q9. BR  [sMiswe [Grot =

. Unit Serial : [ 600000 Q. 813 [SMiswaE [Grot 2|

o Input Status' (On/Off) On. B4 [swiswan [Ground Trgger x|

|

. B w round Trgger
Cenin st Y il [SMT 5w 212 [Ground Trgg

el
| fe R e |
=

: : B T T O
Optlonal Switch Panels E B T — P | e

Window shows:

e Switch Status: (On/OfY)

[SW PuclPump [ S0 Wiater Pup | [S01Pam

Switch Names: [ SW Starter [ 5w 1gniton [ 5w Trans Cooler| [5w Acc [sw Lights

St 0s: St om0 =] [swich om0 =] [swic 0730 =] [swich om0 2] [t 0 x0 =] ot on 0 =] [stch om0 ]

panel may not turn on if the Status ID is

f NOTE: The physical light on the switch
set to one of the output channels.

WARNING: Turns onoff the bus termnating resistor inside the switch panel,

w = 5
SHOULD 52 TURNED ON OFLY FOR LAST SWITCH PANEL INLIIE, oS oo | o |
Sritch Bus Terminating Resistor: [ ON =] Stop Real Tiwe Dspiay | FEAD Corounatin | Eaneel |
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3-Real Time Data on PC

Real Time data from the SmartWire unit can be displayed and recorded on the PC computer using the
DatalinkIl program. However, before viewing real-time data, first setup the real time parameters in the
SmartWire units’ main window by selecting which channels desired to display/record during the real-time

session. The below steps should be performed while connected to the PC and the SmartWire unit powered on.

Supply VIET Bus Power Vihen: o When

 On When Value Meets or Exceeds:  On When Value Meets or Exceeds:
o | || o[ | |

Value:
Al

 Aways On © Aways OFF @ Always On  Aways OFF

Right-click on the SmartWire channel button

An edit dialog box will be displayed. In the center of the dialog box will be a Real — Time Telemetry Section.
This section will contain two lists. The list on the left-hand side of the telemetry section will include all of the
channels currently being monitored by the SmartWire unit. The list on the right-hand side of the telemetry

sections includes all those channels that will be displayed during a real time telemetry session.

To add a channel to the telemetry list, highlight the name of the channel in the left-hand list, and click on the
right arrow button to add the selected channel to the real-time channel list. To remove a channel from the real-
time channel list highlight the name of the channel in the right hand list and click on the left arrow button.
Remember that only channels in the right hand list will be displayed during a real time telemetry session.
Once the channels desired to display are selected, send the selected channels to the SmartWire unit. Do this by

clicking the Send Configuration button

Once the SmartWire unit is programmed for the channels desired to real-time, the configuration file must be

saved. To perform this function, select File in the menu bar and select Save or by clicking the Save icon in the

toolbar
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Starting a Telemetry Session

The next step is to start a telemetry session. Select the Telemetry icon E or go to File and select New Telem

Session.
A dialog box, as shown below, will be displayed which allows X
selection of the configuration file to use for this session. P Sriartire_Coniia

Select the configuration file named SmartWire. A dialog box

I -

will then be displayed to allow entry of the session information

[

(the same as when uploading run data). Since this is most likely cacel | [0k ]

a system test, select the year and enter TEST (or any name that

would reference this particular session) in the Track dialog box. The system will enter the date and time.

session =
2|
Year: 2009 Track: [Anywhere Raceway  Date: [02/27/2009 Time: [11:47:59
2009 - Anywhere Raceways

Set ¥100 Time and Date |
Force New Recording on Next Power Up |

2010

Clear Data Files From Memory Card |

Race Type:
" Warmup  TestSession ¢ Logger Test  Qualifications ¢ Eliminations

Race Sequence:
1 20C3C4CE5CEGCFO O Y

Next->

Select Next, and depending on the configuration file, additional dialog boxes may be displayed. These are part
of the Run Log sections that are user programmable to allow test information to be entered during the download
process. Fill out the information as appropriate and click Next or click OK to continue on if no information is

entered.
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Saveastyps:  |RacePak Data k)

=

Save I
Cancel

The file save dialog box will then be displayed. Select Save if saving this file or click the Cancel button.

Clicking Cancel will still advance to the real-time session window, but no file will be saved at this time. The

opportunity to save the session will be present, later.

A new file tab with the channel data will be opened. This file tab is designated with a blue floppy disk icon.

(shown below).

I o4 Graphl}' Smartyire [ SmTes021911R1 |

In view should be the channel buttons across the top area of the window for each channel selected. Each

channel will have -### next to it. This is normal as the session window is open, but the real-time session hasn’t

yet been started.

Hé Datalinkt
Fle Edit Telemetry Runlog TrackMap View Settings Security Help

-lojx|

& || o Graph| & smartwire B SmTes021911R1 |

) || [smantwire #1 | -###  [SM1Output#8  w|-###  [SM1Output#16 ¥ |-###  [SM1 Output#2a v |-

& || [sM1Output#1  v|-### [SM1Output#o  w|### [SM1Output#17 v|###  [SM1Output#25 v |-

W || [sM1Output#2  ¥|-### [SM1Output#10 ¥|### [SM1Output#18 ¥|###  [SM1 Output#26 ¥ |-

& || [sM1Output#3  ¥|-### [SM1Output#11  ¥|### [SM1Output#19 ¥|###  [SM1 Output#27 ¥ |-
read || [SM1 Qutput#4 ¥ | ###  [SM1Output#12 ¥ | ##  [SM1Output#20 ¥ | #%#  [SM1Output#28 ¥ | ###
wiite || [SM1 Output 85 ¥| ##%  [SM1Output#13  v| ###  [SM1Output#21 ¥|#%& [SM1Output#29 ¥ | s
S || [sm1output#5 | ##¢  [SM1Output#14 ¥ |.###  [SW1 Output#22 ¥ |.###  [SM1 Output#30 ¥ | ###
[SM1Output#7  v| %  [SM1Output#15 ¥ | #2# [SM1Output#23 ¥|#%  [SM1Inputs ¥ | e
Ea

= 1 | ol
Bl

B

The real time session is controlled via two icons located below the context sensitive help icon in tool bar. Only

one icon will be active at a time depending on the status of the telemetry session. The Start Data Acquisition

icon is shown active on the left. The Stop Data Acquisition icon is shown active on the right.

Start Data Acquisition - Green Light

CIEIE:
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To start the real time data acquisition, click on the Start Data Acquisition Icon at the bottom of the tool bar.

Once the real time data acquisition has been started, the value -### on each channel will change to the live

value of each for each channel shown.

=T

File Edit Telemetry Runlog TrackMap View Settings Security Help
o4 Graphl)‘ SmartWire [l SmTes021911R1 |

SmartWire #1 ¥ | ### [SM1Output#6 ¥ | ### [SM1Output#14 ¥|### |SM1Output#22 v | #u#
SM1Output #1 || ###  [SM1Output#7  ¥| ###  [SM1Output#15 ¥|###  [SM1Output#23 | ###
 SM1 Qutput #1 Volt. ##%  [SM1Output#8 ¥ | ###  [SM1Output#16 v | ###  [SM1 Output#24 v | ###
 SM1 Output #1-Stat ###  [SM10Output#9 ¥ | ###  [SM1Output#17 v| ###  [SM1 Output#25 v | #u#
Read || [SM1 Output#2 ¥ | ###  [SM1Output#10 ¥ | ###  [SM1Output#18 ¥ | ###  |[SM1Output#26 ¥ | ###
[SM1Output#3 | ##%  [SM1 Output#11 ¥ | ### |SM1 Output#19 ¥ |###  |SM1 Output#27 v | #
& || [SM1Output#4  w|.### |[SM1Output#12 ¥ | ### |SM1Output#20 ¥ | ### [ SM1 Output#28 v | ###
[SM10utput#5 v | ### | SM1 Output#13 ¥ | ###  [SM1 Output#21 ¥ | ### | SM1Output#29 ¥ |

%u&@h

3

)

E1
- | | ]
)

For each channel there are multiple values that can be displayed. By clicking the down arrow, other parameters

of the channel will be shown.

Main SmartWire

SmartWire #1 Al 119
Chanel shows:  SmartWire #1.Temp | 81.4
 SmartWire #1# Blown || 0

e Voltage at Main power Stud
e Internal Temperature of SmartWire

e Number of Blown Fuses

Output Channels '
SM1 Qutput #1 a| 0.0 |

Channel shows: . SM1 Output #1-Voltage |  0.07 |
o |

| SM1 Output #1-Status

e Current: Amperage on channel

e Voltage: Volts on channel

e Status: status (see table) Value Output Status

Off

On

Delay On

Delay Off
Latched On

128 Blown Fuse

192 Blown Fuse, Retry

O (N[N [—|O
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Hardwired Direct Input Switches

[ S Inputs Al 0 - SM1 Sw #7 0
Channel shows: | SM1 Sw #1 P SM1 Sw #8 0
e Input Status: (On/Off)  SM1 Sw #2 0 ‘Sm1Sw#9 0
o 0=Off 55"" S O lsm1sw#0 0
o 1-0n VTR M O Tsm1 sw#11 0
T O sm1 sw#12 0
i SM1 Sw #6 0 |
Optional Switch Panels -
5P1 Switches & 0 ' SW Fan 1
Window shows: oW S 0 ;
tarter : SW Trans Cooler 1
e Switch Status: (On/OfY) | SW Igniton 1 CSW e 1
o 1=0n | SW Water Pump 1

To select to channel for graphing, simply click on the parameter desired to graph. A color will be
designated to the channel parameter and the graph will have a line in it with a matching color indicating
the value. To remove the channel from graphing, simply click on it again and the color will be removed.

Each time select, a new color will be presented.

To stop the data acquisition, click on the Stop Data Acquisition icon located at the bottom of the tool bar.

The real time data acquisition session will be suspended.

Stop Data Acquisition - Red Light

If desired to continue the real time data acquisition, simply click on the Start Data Acquisition icon. The
telemetry session will restart at the same point it was suspended. If desired to restart the session from the

beginning, select Erase from the Telemetry main menu. All previously recorded data will be erased from the

file.

If desired to save the data, stop the data acquisition, and click the Save icon = | located in the tool bar, or

select File from the main menu and select Save.
Racepak
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Example Programming (Walk through)

The following pages will present the complete setup and programming of a channel. For the following example,
the intent is to configure an input for a “Starter Button” and have it activate the output for the “Starter
Solenoid”. The Starter Button will be wired using one of the Hardwired Direct Inputs on the SmartWire unit:

1. Connect PC to the SmartWire using one of two methods
a. Standalone - with V-Net sensors, no data recorder — Use the provided USB Programming Cable
connected to the SmartWire unit.

b. Via Data Recorder - Use the data recorder’s programming cable connected to the data recorder

2. Confirm the SmartWire unit has power verifying the Power Status light located on the main unit.

3. Open the DatalinkII program by double-clicking the DatalinkII icon found on the computer’s I‘;'IE"p

desktop Datalink
Program

4. Open the configuration file
a. Standalone - File->Open Car Configuration—> SmartWire—>Click OK
b. Via Data Recorder — File>Open Car Configuration=> The Racepak data recorder—=> Click OK
5. Once the configuration is opened, the configuration should be synced with the system. To perform this,

select Edit->Read VET Config or click the Read

1con in the toolbar

6. A message log window will open and start to scroll indicating the reading process has begun, (if an error
is encountered, verify that the power is on, and the communication cables are correct. Click OK. Then
click “yes” to scan all COM ports, repeat step 5 )

7. Once complete, the message log window will show “DEVICES READ SUCCESSFULLY”

8. Once sync’d up and communicating with the SmartWire, the next step is program the input channel. For
this example, we are going to use a hardwired input.
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Input Configuring (Walk through cont.)

1.

2.

Right click on the channel button listed as SM1 Inputs

i~ Individual Inputs

Select an available switch under the Individual Inputss area TRt PnE  Tame Trager e
(shown right). For this example we’ll use Input 1. Take note of | 1+ a0 [fowe Seier Vohage Trigoer Jd
the Pin # for this input as this will be the pin on the 23 pin - :SM‘ — :Gm“”d — j'
. 3 Al SM1 5w H3 Ground Trigger ™
connector used to connect to the button. Pin # A10. n o |SEEm oo 51
5 A3 [sMisw#5 | Ground Trigger |~ |
In the name, type in a name that repesents what this input will 6 AW [sWisws [Ground Tigger ]
be. For this example, we’ll type in HDWI#1 Starter. The C :2:1 - :2“3: fer ﬂ
. . W round Trigger ™
name repesents Hardwire Direct Input # 1 Starter, for starter N (s o =
button. This will make it easy for future reference of this 0. B2 [sMiswel0 [Ground Tioger 15
channel in later programming. 1B susw A |Gourd Tigge x|
12 B8 [suiswaiz | Ground Trigger |~ |
Under the Trigger Level area, click on the drop-down arrow S|
and select the correct “Trigger”, Ground or Voltage. In this Start Real-Tme Diplay | _READ Configuration cancel

example, the Voltage Trigger should be selected.

NOTE: If this was set for Ground Trigger, should the wire short against ground somewhere
between the SmartWire and the ground source, the starter would engage and stay engaged. For
this application, Voltage Trigger is a safer choice.

When set to Voltage Trigger, input channel #1, pin A10 will require a voltage signal greater than 4 volts to
be applied to trigger this input. Considering this is for a Starter, a momentary button conencted to a power
source will be used to trigger the input.

Once the name and trigger level has been set, we can send this change to the SmartWire by clicking the
“SEND Configuration” button in the lower center area of the window.

A message log window will open and start to scrolling indicating writing to the SmartWire is in progress.

Once completed, the message log window will show “DEVICES PROGRAMMED
SUCCESSFULLY”.

Click OK and at this point, returned to the SM1 Inputs window.

. Click OK on the SM1 Inputs window to return to the main configuration window.

. At this point, terminate the A10 pin to a momentary pushbutton and wire the other side of the button

battery power or terminate this at a later date.

& Note: Depending on how many outputs planned on using, it is possible to wire to another output

from the SmartWire and trigger this output with an ignition switch programmed in a similar
fashion.

Note: If the input pin is wired at this point, click the “Start Real-Time Display” button to verify the
signal when pressed. Since output is not configured at this point for this input, no activities occur.
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Output Configuring (Walk through cont.)

An output channel will now need to be configured for the starter button input. This channel will activate the
starter solenoid on the starter motor. Select an output with an appropriate current (Amps) rating by referring to
the Channel Pin Chart located on the inside of the rear cover of this manual. The starter solenoid in most cases
can draw up to 20 Amps. For this example, we’ll select Output #1 Pin A3

1.

2.

In the main configuration window, right click on the channel button SM1 Output #1

The first thing that should be done is to confirm this paticular channels Type: | SMARTWIRE 204

capacity is rated higher than the operating current (Amps) of the device o '
that it is connected to. This is noted by verifing the Type: located in the top right corner of the window.
20A

In the Channel Name text box, type in a name that repesents what this Channel Name: =1 Starter Saenad]

input will be. For this example, we’ll type in O#1 Starter Solenoid. T TN -
The name repesents Output # 1 Starter for which the output will connect to. This will make it easy for
future reference of this channel in later programming.

Take note of the Pin # for this input as this will be the pin on the 23 pin connector used for this button.
This Pin # is located in the bottom left corner of the window. Pin# A3

Verify and set the values for the output channel. These should be set to match the output connecting to.
Below are values that specifically require attention.

Fuse Current: Setting this value below or slightly above the normal

operating current of the device this output is connected may result in Fuse Current; | 20] [0.5 to 30] Amps
inadvertent shutdown of this output. These values should be set curent Graphtan: [0

higher than normal operating current. The purpose of this is to CurentGraphMax: [35 |1 —J Smoothing
protect the wire from overheating should the device fail. Some Volts GraphMin: [0

devices can draw more current under certain situations such as low Volts Graph Max: | 35 [ =] smoothing
battery voltage and increased demand/load. FuseResetDelay: [1 [0 1065 Seconds

Maix Fuse Retries: I 100 [0 to 65535]

Fuse Reset Delay / Max Fuse Retries: When an over-current or

blown fuse situation occurs, the SmartWire will attempt to reactivate

the output. The Fuse Reset Delay determines the amount of time

after the fuse has blown before the output is re-activated. The Max Type: [SMARTWIRE 204
Fuse Retries determines the how many times the SmartWire will Voet10: [smartire +1 x190
attempt to reactivate the output. utoutFuncns Corstant On

Missing VMET Message Logic: ICUnditiUn False

Lef Lef Lef Lo

Logger Sample Rate: ILngging Disabled

Output Function: This sets the function of the output. Select the
one that most represents the desired output. In most cases where on/off is the desired function, as in this
example, Constant On should be selected.

Once these values are set, we can send this change to the SmartWire by clicking the “SEND
Configuration” button in the lower right area of the window.

A message log window will open and start to scroll indicating writing to the SmartWire is in process
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8. Once complete, the message log window will show “DEVICES PROGRAMMED SUCCESSFULLY”
9. Click OK to return to the output channel window.

10. At this point the output is NOT completly configured. The settings have been done for this channel, but

the channel has no logic giving it directions to activate. To do this, the On Conditions must be
configured.
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Logic Configuration (Walk through cont.)

An output channels name and parameters were setup and programmed in previous steps but requires certain
conditions for the output to become active. These conditions are entered in the Logic area of the On/Off
Condition window and are required to be configured before the output channel can be used.

1. In the output channel window, click on the button in the lower right corner labeled On Condition.

On Condition |
I inside box and Right-Click to add or remove conditions ———

SepontControlCharnel | Operation True || Feke | Tue || Fase
dtion| Delay || Delay

|- o | o o
2. This window is where programming for this e j: : : :
output channel is done. Up to ten inputs, Sl
sensors, or outputs connected to the SmartWire j;:: j: : :: ::
unit can be used to create multiple logic | = — | o o
combinations to control the activation of the : j j: : : :
output. O | Cr— | E | £
3. In the Setpoint Control Channel area, select a Setpoint Control Channel by 1. [Wigitnbassg x|
clicking on the drop-down arrow next to the channel =Disabled =(x0) 2 | Mt ot 228 o

[H-5M1 Qutput #26 (x1c9)

+]- SM1 Qutput %28 (x 1ch)
M1 Output #29 {x1cc)

4. A list of channels will appear. These are the available channels to select from.
By selecting a channel and clicking on the + sign next to it, this channel can be
utilized for the logic area. (See Setpoint Control Channel section for more S| spiswihes (is)
details) 1. [HowI=1 Starter (x0120) | 7|

F-SM1 Inputs (x190) -
0 0

L 5M1 5w £2 (x1190)

SM15w =3 (x2190)

SM1 5w #4 (x3190)

- SM1 5w #5 (x4190) |

-SM1 5w #6 (x5120)

- SM15w#7(x6190) |y
504 i ) I 3

7. Here we will select the previously configured Starter input labeled as HDWI#1 Starter.

5. Scroll down to SM1 Inputs and click on the + sign.

6. At this point, note a list of all switches under the SM1 Switches section.

8. As shown in the window below, select the Operation for this input to be True. For our example, the
operation “Equal to” should be selected.

LOGIC - Place cursor inside box and Right-Click to add or remove conditions
Setpoint Control Channel Operation True False True False
Condition | | Condition | Delay Delay
1. JHowiz1starter p0130) 7] |[Equal o =2 E [o [0
Mot Equal to
= = - o I 1 1 a 0
2, | ~Disabled= (x0) T |(Greater than I I I
Greater than or Equal to (1. HDWEE! Starter = 1) &
3. |=l = | [[Less than I_l 1 o 5
Disabled= (x0) Less than or Equal to I I I
4. [=Disabled= (x0) = |[Equal to (| E E Jo [0
5. | =Disabled= (x0) = |[Equal to = [ Jo [0 —
[ |

9. Since the Setpoint Control Channel is an input switch, the only options for switches are either On or Off.
Each position has a value which is 0 = Off and 1 = On. The value to each input cannot be changed.

10. For this output channel, we want the output to activate when the switch is in the ON position (On = 1). For
this to happen, we need to type in “1” (switch on) in the True Condition area for this Setpoint Control
Channel. This basically states that when the input switch (Starter Button) in turned to the ON position
(=1), the condition for this Setpoint Control Channel should become True.

Racepak
30402 Esperanza, Rancho Santa Margarita, CA 92688 USA
Phone: 949-709-5555 Fax: 949-709-5556 www.racepak.com




( 1
{ 36 )

11. In order to activate this output, the previously configured Setpoint Control Channel must be added to the
Logic area on the right area of the window. To add this channel to control the output, Right-click in
LOGIC area and select it. If multiple Setpoint Control Channels are configured, they will show up when
right-clicked. Be sure to select the desired selection.

12. Once these values are set, we can send this change to the SmartWire by clicking the OK button on the
On/Off Condition window. This will return to the output channel window.

13. Within the output channel window, click the “SEND Configuration” button in the lower right area of the
window.

14. Once completed, the message log window will show “DEVICES PROGRAMMED SUCCESSFULLY”

15. Click OK to return to the output channel window.

Understanding Basic Logic Flow:

e Logic conditions are added or removed by right clicking in the Logic area.

¢ Basic flow of the Logic area is:

IF

“Channel X” “&”  “Channel Y” are both true, activate output

OR
IF

“Channel Z” is true, activate output

e The “&” connects two logic conditions together meaning both would have to be True in order for the
output channel to be activated.

e The “OR” separates the logic conditions.

If any Logic condition is True, the output channel condition would then become True and output channel would
be activated.
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SmartWire Firmware Update

Periodically, updates for the internal software on the SmartWire unit known as firmware is required. To perform
the firmware update;

1.
2.

10.

Download and save the appropriate firmware .zip file for the SmartWire from www.racepak.com

Once saved, unzip the .zip file.
NOTE: Note where the unzipped .hex file is located when navigating to this location in later steps.

Apply power to the entire Racepak system.

Connect PC the system in one of the previous mentioned ways (Standalone or With Data Recorder) and

open the car configuration file for the system.

Once the car configuration file is opened, right click on the

Main SmartWire channel button to show the Main

SmartWire Unit Settings.

Click on the Update button next to Firmware Version.

NOTE: The currently installed firmware is shown in the [l e
dialog box, ensure the firmware installed is a greater number =
than the show number St:;:: : T
Click Select to the browse and locate the .hex file. o
Select the .hex file and click Open s

In the Firmware update window, click Start to start the update process.
NOTE: While the unit is being updated, both Status and Power lights
on the SmartWire unit will be solid Green. Should the Status light go
off and Power light start flashing Red, the unit has not accepted the

WN:::& File name: [smartunre w15 hex | Open |
firmware. This could be cause by many things from a corrupt o CCEm 1 ==
firmware file to an interruption during the flashing process. I
It is best to cycle the power off/on and restart the update, [f ~~ File: 2o S 2200 Beaneri Sratiie Snand

Status: I Connect USB cable to SmartWire and click the Start button ===> Start
problem continues, try re-downloading the firmware file e |
from the website. If issue continues, the unit can be sent to

5I

Racepak for firmware update/inspection.

SmartWire was successfully updated to firmware version 15,

Once firmware update is complete a window will appear

indicating a successful update.

Racepak
30402 Esperanza, Rancho Santa Margarita, CA 92688 USA
Phone: 949-709-5555 Fax: 949-709-5556 www.racepak.com




( )|
L 38 )
Channel/Pin Chart
Sorted by Pin Number
"A" Connector "B" Connector
PIN CH# Type AMP PIN CH# Type AMP
A1l 4 Output 20 B1 5 Output 20
A2 10 QOutput 10 B2 22 QOutput 10
A3 1 Output 20 B3 7 Output 20
A4 11 Output 10 B4 28 Output 10
A5 13 Output 10 B5 25 Output 10
A6 2 Output 20 B6 8 Output 20
A7 15 Output 10 B7 26 Output 10
A8 3 Output 20 B8 6 Output 20
A9 12 Output 10 B9 21 Output 10
A10 1 Input B10 7 Input
A11 3 Input B11 8 Input
A12 4 Input B12 9 Input
A13 5 Input B13 10 Input
A14 6 Input B14 11 Input
A15 20 QOutput 10 B15 27 Qutput 10
A16 9 Output 10 B16 18 Output 10
A17 19 Output 10 B17 24 Output 10
A18 2 Input B18 12 Input
A19 NA ground B19 NA Ground
A20 NA ground *B20 On/Off Shutdown*
A21 14 Output 10 B21 23 Output 10
A22 16 Qutput 10 B22 29 Qutput 10
A23 17 Qutput 10 B23 30 Qutput 10
*Grounding the Shutdown pin will turn off power to the SmartWire unit and all outputs.
Sorted by Channel Number
"A" Connector "B" Connector
CH# Type PIN AMP CH# Type PIN AMP
1 Output A3 20 5 Output B1 20
1 Input A10 6 Output B8 20
2 Output A6 20 7 Output B3 20
2 Input A18 7 Input B10
3 Output A8 20 8 Output B6 20
3 Input A11 8 Input B11
4 Output A1 20 9 Input B12
4 Input A12 10 Input B13
5 Input A13 11 Input B14
6 Input A14 12 Input B18
9 Output A16 10 18 Qutput B16 10
10 Output A2 10 21 Output B9 10
11 Output A4 10 22 Output B2 10
12 Output A9 10 23 Output B21 10
13 Output A5 10 24 Output B17 10
14 Output A21 10 25 Output B5 10
15 Output A7 10 26 Output B7 10
16 Output A22 10 27 Qutput B15 10
17 Output A23 10 28 Qutput B4 10
19 Output A17 10 29 Qutput B22 10
20 Output A15 10 30 Qutput B23 10
NA ground A19 NA Ground B19
NA ground A20 On/Off Shutdown* *B20

*Grounding the Shutdown pin will turn off power to the SmartWire unit and all outputs.
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